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EXPLORING RENDER MODE

Lesson overview
In this lesson, you’ll explore how to render a 3D scene and learn 
the following:

• �e three different places that rendering takes place in Dimension, 
and how they differ from one another

• �e limitations of on-canvas rendering

• �e trade-offs between render speed and quality

• How to achieve the highest-quality rendered image

�is lesson will take about 45 minutes to complete. Please log in to your 
account on peachpit.com to download the lesson files for this lesson, 
or go to the “Getting Started” section at the beginning of this book and 
follow the instructions under “Accessing the lesson files and Web Edition.” 
Store the files on your computer in a convenient location.

Your Account page is also where you’ll find any updates to the lesson 
files. Look on the Lesson & Update Files tab to access the most 
current content.

4
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Dimension’s Render Mode produces a 2D scene from 
3D models, complete with realistic light, shadow, 
materials, and re�ections.
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What is rendering?
Rendering refers to the process of producing a realistic-looking 2D scene from a 
3D model or models.

Dimension uses a form of rendering called ray tracing. A high-level explanation of 
ray tracing is that the computer has to calculate a path from each pixel in the scene 
back to the camera and calculate the color of that pixel based on the environment 
lighting, the sunlight, the material applied to the surface, and reflections from 
other objects. �is requires a lot of computing horsepower, and is far too complex 
for today’s computers to accomplish in real time as a scene is edited.

Because of this, Dimension offers three levels of rendering: a rough “on-canvas” 
rendering that Dimension performs as you edit a 3D scene, a render preview, and 
Render mode.

On-canvas rendering
As you position 3D models in Design mode, Dimension attempts to display a real-
istic preview of the resulting scene on the canvas. Because an accurate rendering of 
the scene is so time-consuming, this on-canvas preview is only a rough approxima-
tion of what the final scene will look like. Effects that will appear especially rough 
in the on-canvas preview include

• Shadows cast by 3D models on the ground plane

• Glass and other semi-transparent materials applied to 3D model surfaces

• �e camera depth of field

�ings that don’t display at all in the on-canvas preview include

• Reflections cast on one model by another model

• Reflections cast by models on the ground plane

� Note: Dimension 
uses a proprietary ray 
tracing renderer owned 
by Adobe. Earlier ver-
sions of Dimension used 
a ray tracing renderer 
developed by Chaos 
Group. If you wish to 
use this earlier render-
ing engine, you can 
switch the renderer in 
Dimension’s Preferences 
(Adobe Dimension CC > 
Preferences on the Mac, 
or Edit > Preferences on 
Windows).
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1 Launch Adobe Dimension.

2 Click Open, or choose File > Open.

3 Select the file named Lesson_04_begin.dn, which is in the Lessons > Lesson04 
folder that you copied onto your hard disk, and then click Open.

4 Note some of the limitations of the on-canvas rendering of this scene. �e 
shadows being cast by the two 3D models are hard-edged. 

You’d expect to see some part of the wood model being reflected in the shiny 
silver surface of the Pipe model, but the reflection isn’t visible.
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5 Select Environment in the Scene panel.

6 Click the disclosure triangle  to the right of Ground Plane in the Properties 
panel to reveal the ground plane options. 

Because there is a Reflection Opacity value of 10%, you’d expect to see a slight 
reflection of the 3D models in the ground plane, but no reflection appears in the 
on-canvas preview.

�e bottom line is that the on-canvas preview is useful primarily as a way to judge 
the position, size, and placement of 3D models within a scene. To see materials, 
surfaces, and lighting accurately, you must render the scene.

Render preview
�e Render Preview window provides a pretty good idea of what the final render 
will look like, but the quality of the preview is limited so that the preview can 
update quickly as you edit the scene. 

1 Click the Render Preview icon  at the upper-right corner of the work area.

2 Wait for the render preview to update.

3 Click the Toggle Fullscreen icon  at the top of the Render Preview window to 
view a larger preview.

4 Note the rough, speckled “noise” in the shadows in the render preview. �is is a 
limitation of the render preview.
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You can adjust settings in the Properties panel, even while the full-screen 
Render Preview window is displayed on the screen.

5 In the Scene panel, click Environment.

6 In the Properties panel, turn on Sunlight.

7 Change the Rotation value to 130°.

You should see new cast shadows, caused by the sunlight, appearing to the left 
of the objects.

8 Click the Close icon  in the upper-right corner of the Render Preview 
window to close it.

9 In the Properties panel, turn off Sunlight. � Tip: Use the \ key 
to show and hide 
the Render Preview 
window.



66 LESSON 4 Exploring Render Mode

Render mode
To really see an accurate view of the scene, the scene must be rendered in 
Render mode. 

1 Before you go to Render mode, click the Camera Bookmarks icon  at the 
top of the screen.

You’ll see that there are five bookmarks saved with this file.

2 Click each bookmark in turn to see what each view looks like.

3 When you’re finished, click the “Front view” bookmark to return to that view.

4 To enter Render mode, click the Render tab at the top of the screen.

In Render mode, you’ll see all five of the camera bookmarks displayed at the top 
of the Render Settings panel. �is handy feature lets you render multiple camera 
views of a scene all at once. Since rendering can be very time consuming, 
this provides a way to queue up multiple renders of a scene and let them run 
overnight or while you’re at lunch.

For now, just leave “Current View” selected.
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5 Type My_Lesson_04_end LOW in the Export Filename field. Dimension 
appends the name of the view to the end of the filename, so this file will be 
exported as My_Lesson_04_end LOW-Current View.

6 If you want to change the export location, click the blue export path and choose 
a new export location.

7 In the Quality setting, choose Low (Fast).

8 Deselect PSD under Export Format, and select PNG.

9 Click Render.

10 Wait for the render to finish.

�e render took about 1 minute and 23 seconds on my 3-year-old MacBook Pro. 
If you don’t want to wait for the render to finish, I’ve saved a copy of the rendered 
file for you in the lesson files (Lesson_04_end LOW-Current View.png).

� Note: Although you 
can’t continue to work 
in Dimension while a 
�le is being rendered, 
you can continue 
to work in other 
applications on your 
computer. If you have 
noti�cations turned 
on in your operating 
system, you’ll receive a 
noti�cation when the 
render is complete.
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11 Now change the Quality setting to High (Slow).

12 Change the filename to My_Lesson_04_end HIGH.

13 Click Render.

Wait for the render to finish. �is render took almost 6 minutes on my 
computer. If you don’t want for it to finish, I’ve saved a copy of the file for you in 
the lesson files (Lesson_04_end HIGH-Current View.png).

While a file is rendering, the Render Status panel displays a progress bar that 
provides a rough approximation of how much of the render has completed.

Render speed and quality
As you’ve seen, there are three Quality settings available in Render mode: Low 
(Fast), Medium, and High (Slow). How do these settings compare?

1 Use Adobe Photoshop to open the two files you just rendered or, if you wish, 
the Lesson_04_end HIGH-Current View.png and Lesson_04_end LOW-Current 
view.png files included in the lesson files.

� Tip: While a �le is 
rendering, you can click 
the Snapshot icon  
at any time to save a 
PNG or PSD �le of the 
render in progress. 
Since the render engine 
performs multiple 
“passes” through 
the scene, a partially 
completed render may 
be far enough along to 
give you a good idea of 
what the �nal render 
will look like.
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2 Examine the files closely. You’ll see that the low-quality render (on the left in 
the accompanying image) contains a lot of noise, which is particularly visible in 
the shadows. �e high-quality render (on the right) contains much smoother 
shadows and less noise.

You’ll need to determine which render quality you need when you render. 
Rendering can be very slow. �is is a simple file, and it’s only 1200 x 800 pixels 
in size. Larger, more complex files can take much, much longer to render.

Render export formats
So far, you’ve been rendering into the PNG format. But you may have noted that 
you can also choose PSD as an output format. What are the advantages to render-
ing as a PSD file?

�ere is no difference in the quality of the rendered image between the two formats. 
�e difference is that the PSD file will contain extra layers and masks that would 
make it easier to edit the 2D scene later if necessary. You’ll learn about this in more 
detail in a later lesson. But for now, open the lesson file named Lesson_04_end 
HIGH-Current View.psd and examine the Layers panel in Photoshop to view the 
extra data included in a PSD render.
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Factors that influence render speed
The time it takes for Dimension to render a scene can vary signi�cantly from �le to 
�le and is in�uenced by a number of factors. I’ve ranked these factors from most 
signi�cant (hardware) to least signi�cant (memory).

Hardware

The speed of the CPU (central processing unit) on your computer has a big e�ect on 
render speed. Generally speaking, the faster your processor, the quicker rendering 
will complete. Modern CPUs with more cores and higher speeds will render fastest.

Materials

More than any other factor, the combination of materials used in a scene has a huge 
impact on the length of time it takes to render the scene. In general, translucent 
materials like glass, liquids, or gels render more slowly than other materials.

Reflections

Re�ections on shiny surfaces slow rendering. This includes objects that are re�ected 
on the shiny surfaces of other objects around them, as well as a ground plane with a 
Re�ection Opacity greater than zero so that models re�ect on it.

Focus

The Focus feature, which simulates depth of �eld—causing some objects to be 
blurred and others to be crisp—slows rendering times.

Canvas size

The total pixel dimensions of the canvas a�ects render speed. The more pixels, the 
slower the render time.

Number and complexity of models

Surprisingly, the complexity and number of models in the scene don’t have a very 
large e�ect on render speeds.

Memory

The amount of memory you have installed on your computer has little e�ect on 
rendering speeds.
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Review questions
1 What is ray tracing? 

2 What are the three places that the 3D scene is rendered into 2D in Dimension?

3 Do reflections appear in the on-canvas preview?

4 What is the most visible limitation of the render preview?

Review answers
1 Ray tracing refers to the rendering method used by the rendering engine built into 

Dimension. Ray tracing performs complex mathematical calculations to determine the 
precise color of each pixel in the scene.

2 Dimension performs rendering in three places: the on-canvas preview, the Render 
Preview window, and Render mode.

3 No. Reflections cast by objects on the ground plane, and cast by objects on other 
objects, will not appear in the on-canvas preview.

4 Because it renders as quickly as possible, the render preview displays a lot of noise, 
especially in shadows.
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INDEX

SYMBOLS

2D backgrounds, 198–200
3D axis, 31
3D backgrounds, 201–203
3D design creation, 233–234
3D modeling software, 224
3D models, 8, 72–91

Adobe Stock as source of, 79–85
creating in Photoshop, 89
Dimension starter assets as, 74–79
importing from various sources, 85–88
industry-standard formats for, 85
potential problems importing, 89–90
review questions/answers on, 91
rigged versions of, 79

A

Actions panel, 14, 51, 164, 210
Add and Import Content icon, 74, 80, 81, 

86, 94
Add to Selection icon, 143, 154
Adobe Authorized Training Centers, 5
Adobe Bridge, 192
Adobe Capture. See Capture mobile app
Adobe Dimension. See Dimension
Adobe forums, 4
Adobe Illustrator. See Illustrator
Adobe Photoshop. See Photoshop
Adobe Standard Material, 94
Adobe Stock models, 79–85

adding to scenes, 80–82
browsing for free, 80
modifying in scenes, 82–83
saving to your library, 84, 85, 162, 

173, 190
searching via CC Libraries, 84–85, 

162, 173
AI files, 163, 183, 186
Align to Scene option, 147, 159

artboards, 167, 168
assets

Adobe Stock, 80–85
Dimension starter, 27–29, 74–78

attributes, material, 123–125

B

Background Color layer, 261, 262
Background Image layer, 262, 263
background images, 186–197

adding to existing scenes, 191–194
auto-generated lights from, 188–189
custom environment light and, 210, 214
editing in Photoshop, 263–264
matching scenes to, 193–194, 195–196
methods for importing, 204
models added to scenes with, 189–191, 

196–197
replacing in Photoshop, 262–263
starting projects with, 186–191

backgrounds, 184–204
2D built in Photoshop, 198–200
3D built in Dimension, 201–203
color of, 26–27, 171–172, 261–262
creating your own, 198–203
editing in Photoshop, 261–264
graphics used as, 163–165
importing images as, 51, 186–194, 204
matching perspective to, 187, 193, 

195–196
review questions/answers on, 204
workflows for adding, 186

bitmap images
environment light and, 216
material properties and, 105

Blend Edge value, 125
blog, Dimension, 4
blue dot icon, 90
Blur Amount slider, 57
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bookmarks
Home view, 56
naming/renaming, 44, 46, 163
rendering views from, 66
saving, 44, 46, 58
updating, 55

Break Link to Material icon, 111, 112, 
114, 255

Bridge, Adobe, 192
Brightness/Contrast adjustment layer, 263
building new models, 222–257

3D design creation, 233–234
borrowing materials for, 253–255
breaking apart objects for, 247–250
extracting parts of models for, 250–252
Lego brick model, 225–228
planes used in, 242–247
review questions/answers on, 257
step and repeat for, 235–242
submarine model, 229–232

C

camera, 16, 42–58
adjusting, 37–38
bookmarks, 44, 55–56
Dolly tool, 50
explained, 44
Focus controls, 56–57
Horizon tool, 51–55
Orbit tool, 45–48
Pan tool, 48–50
review questions/answers, 58

camera bookmarks. See bookmarks
Camera Bookmarks icon, 38, 44, 55
Camera Bookmarks panel, 56
Camera icon, 121
Camera Raw Filter, 269
Camera Undo command, 16
camera views, 66
canvas, 17

render speed and size of, 70
sizing/resizing, 26, 41

Capture mobile app, 118–139
capturing materials with, 120–129
description and purpose of, 120
downloading and installing, 120
modifying materials from, 131–138
use of materials from, 130–131

capturing materials, 120–129
Classroom in a Book training series, 1
clicking, to select multiple objects, 142–144
Cloudiness slider, 214, 221
Color Overlay layer style, 265–266
color picker, 261
Color Sampler icon, 172, 212
Colorize option, 36, 212, 214
colors

background, 26–27, 171–172, 261–262
correcting in images, 269
environment light, 36
material, 102
sampling, 182

Content Aware Fill, 216
Content panel, 27–28
contrast adjustments, 264
Create Environment Light option, 211
creating models. See building new models
Creative Cloud Libraries

importing models from, 81
saving materials to, 125, 129
saving models to, 84, 85, 162, 173, 190
searching Adobe Stock via, 84–85, 162
storing assets in, 82

Cube model, 226, 244–245
customizing

environment light, 210–212
materials on models, 255–256

Cylinder model, 227, 229, 231, 246

D

default preferences, 4
Depth Information layer, 268
depth-of-field simulation, 56–57
Deselect All command, 144, 150
Design mode, 21, 24–41

background color change in, 26–27
camera adjustments in, 37–38
lighting adjustments in, 35–37
materials application in, 33–34
moving objects in, 29–30
new project creation in, 26
review questions/answers on, 41
rotating and scaling objects in, 32–33
starter assets in, 27–29

Detail value, 123
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Dimension
described, 8
filename extension, 27
help content, 22
installing, 2
modes, 21–22
preferences file, 4
resources, 4–5
starting, 2, 10
steps in using, 9

Disc model, 242, 243, 246–247, 257
DN files, 27, 41, 171
Dolly tool, 50, 52–53, 54, 58
dragging-and-dropping

graphic files, 169, 192
materials onto objects, 98–99
models into scenes, 87

Drop model, 237
Duplicate command, 236, 257

E

editing
backgrounds in Photoshop, 261–264
graphics in Illustrator, 170–171

educator resources, 5
environment light, 208–212

adjusting, 35–36
Adobe Stock for, 215
bitmap images for, 216
creating custom, 210–212
experimenting with, 208–210
file formats for, 217, 221
image-based, 215
rotating, 35, 212
using custom, 214–216
See also sunlight

Esc key
backing out of materials view using, 98
selecting parent groups using, 151

export formats, 69
EXR image files, 217
eyeball icon, 14, 97, 151

F

FBX file format, 85
file formats

environment lights and, 217
standard for 3D models, 85
supported for graphics, 163, 183

files
info about lesson, 2, 3
limit on opening, 11

Filter by Models icon, 75
Focus controls

depth-of-field simulation and, 56–57, 58
render speed and use of, 70

forums, Adobe, 4
Frame All command, 46, 84, 202
Frame Selection command, 84, 248
Frequency value, 123

G

geometric models, 224–225
glass properties, 105–106
Glow property, 219, 220
Glowing material, 217, 219
graphics, 160–183

adding background, 163–165
advanced techniques for, 173–182
applying additional, 165–169
background color for, 171–172
dragging and dropping, 169, 192
editing in Illustrator, 170–171
file formats supported for, 163, 183
fixing overlap of, 178–182
materials distinguished from, 183
modifying properties of, 169
placing overlapping semitransparent, 

174–178
renaming in Scene panel, 167
review questions/answers on, 183
saved in DN files, 171

grid
ground plane, 20, 45
perspective, 196

Grid view, 96
ground plane, 18–20

adjusting properties of, 37
grid lines on, 20, 45
objects positioned below, 90
See also planes

Group icon, 98–99, 104
Group Select option, 149–151, 159
groups

creating object, 77, 78, 228, 240
extracting models from, 248–249, 252
renaming models in, 163
selecting parts of, 149–151, 159
viewing models in, 99, 246
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H

Hand tool, 12
hardware factors, 70
HDR image files, 217
height, sunlight, 214, 221
help content, 22
Hollow Sphere model, 233
Home view, 18, 56, 191
horizon line, 52, 53, 55, 195, 199–200
Horizon tool, 51–55, 195–196, 199, 204
horizontal plane, 202

I

IBL file format, 217
Illustrator

artboards from, 167
editing labels in, 170–171

Image as Background option, 51
Image as Light option, 216
image icon, 127
images

color correcting, 269
importing as lights, 216
noise in low-quality, 40, 69, 71
See also background images

importing
3D models from other sources, 85–88
Adobe Stock models from CC 

Libraries, 81
images as backgrounds, 186–194
images as lights, 216
potential problems with, 89–90

installing
Adobe Capture, 120
Adobe Dimension, 2

Intensity value, 123, 213

J

JPEG files, 163, 183, 186, 216, 217

K

keyboard shortcuts
for Content panel, 77
for grouping/ungrouping models, 77
for Render Preview window, 65
for selecting/unselecting, 144
for tools in the Tools panel, 12
for zooming in/out, 17

L

layers
Background Color, 261, 262
Background Image, 262, 263
Depth Information, 268
Material Selection Masks, 266–268, 270
Object Selection Masks, 264–266, 267

Layers panel, 260, 263
Learn icon, 22
Lego brick model, 225–228
lesson files, 2, 3
libraries. See Creative Cloud Libraries
licensing assets, 84, 85
lights, 206–221

adjusting, 35–36
auto-generated, 188
environment, 35–36, 208–212
file formats for, 217
glowing materials as, 217–220
importing images as, 216
review questions/answers on, 221
sunlight, 36, 189, 212–214
types of, 208, 221

Lights icon, 214
linking/unlinking materials, 111–116

breaking a link, 112–113
en masse material application, 111–112
independent material application, 

113–114
Paste commands and, 115–116
Sampler tool and, 114–115
summary points about, 116

List view, 34, 96
Lock icon, 87, 193, 197

M

Magic Wand tool, 11
partial model selections with, 

106–109, 117
Photoshop post-processing with, 

265, 267
surface selections with, 152–154, 155, 

178–179, 183
marquee selections, 144–149
masks, selection, 264–266
Match Background Aspect Ratio icon, 193
Match Camera Perspective option, 

51, 195, 199
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Match Image command, 51, 187, 193,  
195–196, 199, 204

Match Sunlight option, 195, 199, 213
Material Definition Language (MDL), 94
Material Selection Masks layer, 

266–268, 270
materials, 92–117

adjusting attributes of, 123–125
applying to objects, 33–34, 96–100
bitmap images added to, 105
borrowing from other models, 253–255
capturing with Adobe Capture, 120–129
changing properties of, 102–106, 

131–138
customizing on models, 255–256
dragging and dropping, 98–99
en masse application of, 111–112
finding sources of, 94–96
fixing seams visible on, 133–134
glowing, used as lights, 217–220
graphics distinguished from, 183
independent application of, 113–114
metallic value adjusted for, 137–138
naming/renaming, 125
Paste commands for applying, 115–116
Photoshop adjustments to, 266–268
previewing in Render Preview, 100–101
render speed and use of, 70, 97, 117
review questions/answers on, 117, 139
rotation adjustments for, 132, 156–157
Sampler tool for applying, 114–115
sampling from other models, 99–100
scaling relative to model, 132–133
sub-selecting model faces for, 106–110
summary of linking rules for, 116
surface detail adjustments for, 134–136, 

155–157
unlinking instances of, 102, 111, 

112–113
Materials icon, 33, 95, 219
memory, render speed and, 70
Metallic value, 102, 123, 138, 139, 169
Model icon, 28, 219
models

Adobe Stock as source of, 79–85
borrowing materials from, 253–256
breaking apart components of, 247–250
creating in Dimension, 222–257
Dimension starter assets as, 74–79
dragging and dropping into scenes, 87

extracting parts from, 250–252, 257
graphics applied to, 160–183
importing from other sources, 85–88
materials applied to, 33–34, 92–117
render speed and complexity of, 70
saving to CC Libraries, 84, 85, 162, 

173, 190
sub-selecting parts of, 106–110
See also 3D models; building new models

More icon, 34, 96, 125
Move to Ground command, 90, 91, 201, 230
moving objects, 29–30

N

naming/renaming
bookmarks, 44, 46, 163
graphics, 167
groups, 163
materials, 125

NASA 3D models, 87
New project option, 162, 173
New Selection icon, 144
noise, image, 40, 69, 71
normal map, 123, 134–136

O

OBJ models, 85, 86–88, 91
Object Selection Masks layer, 264–266, 267
objects

breaking apart, 247–250
moving, 29–30
rotating, 32, 33, 41
scaling, 32
selecting, 142–151

on-canvas rendering, 62–64
online content, 2–3
Orbit tool, 45–48, 54
overlapping graphics

fixing problems with, 178–182
placing semitransparent, 174–178

P

Pan tool, 48–50, 58
panels

Actions, 14, 51, 164, 210
Camera Bookmarks, 56
Content, 27–28
exploring, 13–15
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panels (continued)
Layers, 260, 263
Properties, 14–15, 30, 102–104, 106
Scene, 13–14, 29–30, 75, 98
Tools, 11–12

panorama images, 216
Partial Marquee Select option, 145, 146, 

148, 159
Paste as Instance command, 116
Paste command, 115
perspective

automatically matching, 187, 193
manually adjusting, 195–196, 199, 204

perspective lines, 51, 52, 187, 193
photographs

capturing materials from existing, 
125–129

taking to capture materials, 122
Photoshop

2D backgrounds from, 198–200
3D models created in, 89
backgrounds edited in, 261–264
color correcting images in, 269
graphics edited in, 170
masks for making selections in, 264–266
materials adjusted in, 266–268
opening rendered scenes in, 260
post-processing with, 258–270
viewing rendered scenes in, 39–40

Pipe starter asset, 28
Pivot property, 237, 240
pixel dimensions, 162
Place Graphic on Model icon, 164, 165, 

167, 175, 181
Plane model, 201–203, 242–244, 257
planes, 242–247

alternative to, 244–247
rotation of, 201, 244
vertical and horizontal, 202
working with, 242–244
See also ground plane

PNG files, 67, 68, 216, 217, 260, 270
Pointillize filter, 268
positioning

default, for starter assets, 29, 41
imported model problems with, 90
objects with Properties panel, 30

post-processing, 258–270
backgrounds edited in, 261–264
color correcting images in, 269
masks for making selections in, 264–266

materials adjusted in, 266–268
opening rendered scenes for, 260
review questions/answers on, 270

preferences file, 4
previews

lighting, 208
material, 100–101
render, 20–21, 62–65

Prism starter asset, 28
properties

graphic, 169
ground plane, 37
material, 102–106, 131–138
visual explanation of, 102

Properties panel, 14–15
changing material properties in, 

102–104
increasing/decreasing numeric 

values in, 106
pixel dimensions adjusted in, 162
positioning objects using, 30

proportional scaling, 32, 176
PSD files, 39, 69, 183, 186, 260, 270
Publish to Web feature, 21

Q

quality, render, 68–69

R

ray tracing, 62, 71
Reflection Opacity slider, 37
Reflection Roughness slider, 37
reflections

on-canvas previews and, 62, 64, 71
render speed and use of, 70

renaming. See naming/renaming
Render mode, 21, 38, 66–71

export formats, 69
Quality settings, 68–69
review questions/answers, 71
steps for using, 66–68

Render Preview window, 20–21, 64–65, 
100–101, 208

Render Status panel, 68
rendering, 38–40, 60–71

explanation of, 62
export formats for, 69
multiple camera views, 66
on-canvas preview of, 62–64, 208
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quality settings for, 68–69
Render mode options for, 66–68
Render Preview window for, 20–21, 

64–65, 100–101, 208
speed of, 68–69, 70, 97

Repeat value, 124
repositories of 3D content, 88
resizing. See sizing/resizing
resources, Dimension, 4–5
review questions/answers

on 3D models, 91
on backgrounds, 204
on building new models, 257
on the camera, 58
on Design mode, 41
on graphics, 183
on lights, 221
on making selections, 159
on materials, 117, 139
on post-processing, 270
on Render mode, 71

rigged models, 79
rotating

environment light, 35, 212
materials, 132, 156–157
objects, 32, 33, 41
planes, 201, 244
sunlight, 214

Rotation icon, 132
rotation widget, 32, 33
rotational step and repeat, 237–242

steps in process of, 237–239
workaround for non-model points, 

239–242
Roughness value, 103, 123, 137, 169

S

Sample Color icon, 182
Sampler tool, 11

borrowing materials using, 254–255
materials applied with, 99–100,  

114–115, 117
saving

Adobe Stock models, 84, 85, 162, 
173, 190

camera bookmarks, 44, 46, 58
captured materials, 125
stock images, 129

scale widget, 32, 33

scaling
graphics, 165, 176
imported models, 89
materials, 132–133
objects, 32, 33
proportional, 32, 176
See also sizing/resizing

Scene panel, 13–14
backing out of, 98
graphics in, 166, 169, 176
moving objects using, 29–30
naming/renaming items in, 167
open vs. closed groups in, 75
practice of referring to, 142

scenes
background images added to, 191–194
introduction to rendering, 38–40
models added to, 80–82, 87, 189–191, 

196–197
scrubby sliders, 106
seams, fixing in materials, 133–134, 139
searching Adobe Stock, 84–85, 162, 173
Select and Move tool, 11, 12, 142–143, 144, 

145, 147, 150
Select and Rotate tool, 11, 32, 33, 201, 212, 

237, 240
Select and Scale tool, 11, 32, 33, 226, 

227, 232
Selection Size slider, 153, 154
selection tools

changing options for, 144
selecting objects using, 142–151

selection widget, 164
selections, 140–159

clicking for multiple object, 142–144
Group Select option for, 149–151
Magic Wand tool for surface, 

152–154, 155
marquee select for multiple object, 

144–149
masks for making in Photoshop, 

264–266
review questions/answers on, 159

semitransparent graphics, 174–178, 
262, 270

Set Focus Point button, 57
Shift key

for property value changes, 106
for proportional scaling, 32, 176
for selecting/unselecting, 144, 154
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shopping cart icon, 84, 85, 162, 173
simulations, depth-of-field, 56–57
sizing/resizing

canvas, 26, 41
selections, 153, 154
See also scaling

SKP file format, 85
Smart Filters, 269
Snapshot icon, 68
speckled appearance, 97, 117
speed, render, 68–69, 70, 97
Sphere model, 230, 231, 240
Star model, 108–110
Start screen, 4, 10
starter assets, 27–29, 74–78

examination of, 74–77
geometric models as, 224–225
modification of, 77–79
positioning of, 29, 41

step and repeat, 235–242
Dimension process for, 235–236, 257
rotational, 237–242

STL file format, 85
stock sources for 3D content, 88

See also Adobe Stock models
Studio Panels Light option, 215
submarine model, 229–232
Subtract from Selection icon, 143, 154
sunlight

adjusting, 36, 189, 213–214
experimenting with, 212–214
options for, 189, 213–214
rotating, 214
See also environment light

surfaces
adjusting detail of material, 134–136
changing materials applied to, 155–158
graphics applied to model, 160–183
selecting with Magic Wand tool,  

152–154, 155
SVG files, 94

T

Temperature slider, 269
textures, Adobe Stock, 127–128
TIFF files, 163, 183, 186
Toggle Fullscreen icon, 64, 208
Tools panel, 11–12
tooltips, 11
Translucence properties, 105–106
transparency, graphic, 173, 174, 262
Trash icon, 244, 249, 251
tutorials, 4

U

Undo command, 16
Undo Edit Graphic option, 164
Ungroup command, 242
Unlink icon, 102
unlinking materials. See linking/unlinking 

materials
updating camera bookmarks, 55

V

vertical plane, 202

W

Web Edition of book, 3
web resources, 4–5

X

X icon, 33
x-axis, 31

Y

y-axis, 31

Z

z-axis, 31, 41
zero point, 29
Zoom to Fit Canvas option, 162, 173
Zoom tool, 12, 17
zooming in/out, 17
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